
Interactive Mapping Frequently Asked Questions (FAQs)       
    

                For the Complete Help document  
http://imapp.vcgov.org/mox6/help/MapOptix%2060%20User%20Guide.pdf 

Introduction 
Volusia County’s web services are meant to provide our customers a variety of options and a great deal of flexibility in how they can 
be used. As a result the interactive maps are more complicated than you would find compared too many other agencies. While the 
many icons and pull down menus may appear a bit daunting at first it is actually pretty simple to get to a Property Record Card, use 
the tools, or to query for an address or a parcel number. Please take a few moments to read through the FAQs that follow to see some 
of the many capabilities available to you. We hope you find the County interactive maps useful. 

Web Brower Requirements  
This application is compatible with the latest versions of either Internet Explorer or Firefox. 

It will not function properly with Internet Explore r versions earlier than 7.0 or with Google Chrome. 

You will want to make sure browser settings have been properly configured prior to using.  

Since this site is dynamic you will need to adjust your browser caching. Most browser settings by default will cache previous pages to 
reduce page load times.  

If you are using Internet Explorer, change the cache settings by choosing “Internet Options” under the browser “Tools” menu.  Under 
the General tab of the Internet Options dialog menu there will be a section titled Browsing history. Click on the “Settings” button and 
specify the option “Every time I visit the webpage”.  Make sure you click the “OK” button at the bottom of the menu to save any 
changes. 

This site uses popup windows for specific functionality such as printing and saving map images . Browser popup blockers should be 
configured to allow popups from the application site.  

Internet Explorer’s popup blocker can be changed in the Tools menu bar. Other popup blockers, such as those provided by Google or 
Yahoo will also need to be configured.  

If you are using Firefox, click on the browser Tools menu and choose the Options menu. Click on the “Content Icon” to turn off the 
popup blocking feature. 

 
Interface Components  
 
Toolbar – This is located at the top of the interface and includes tools for map navigation, query, markup and graphical 
selection.  
 
The toolbar has a different look for MapIT but the tools work the same. MapIT has pulldowns for the Query, map tips and 
measuring tools and the Selection tools. Click on the arrow for “Query/Info” or “Selection” to expand the choices. 
 
Map – This window is used to display the main map.  
 
Sidebar – This list bar style menu contains separate forms for layer display management, tabular query, markup feature 
management, etc.  
 
Results – This window displays map and tabular query results. (E.g. Identify, Drilldown, Buffer, Spatial Query, Tabular 
Selection, etc.)  Not shown, it will appear at the bottom of the screen when needed. 
 
 
 



The Kiosk has the tools across the screen. Click the icons or arrows for more choices or to change the layer. 
 

�
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The MapIT Toolbar  has some tools grouped – click on the arrow or icon to expand the choices. 
 

�
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Tools – Click the icon to select it. 

 Zoom In  Click on the map, holding down the mouse pointer,  draw a box on the map to zoom in. 

 
Zoom Out Click on the map. The map will zoom out 20% and center on the clicked location. You 

can also click and draw a box to zoom out. 

 Zoom Previous Returns to previous map display 

 Pan Click on the map and drag to pan, release the mouse button. 

 
Zoom Full Extent Show whole map 

 Identify Choose a layer, then click on the map, an informational popup window will display 

 
Map Tip Choose a layer, an informational popup window will display when hovering the mouse 

over a map feature. 

 
GeoSearch  
“Drill Down” 

Spatial intersection query – the ability to drill through multiple layers returning selection 
results.  Click a feature on the map. The selected feature will be used to select features 
from other layers based on a spatial intersection. 

  
Clear Clears the identify window, clears the buffers or clears the selected layer 

 
Measure Length 

Click two points on the map. Additional mouse clicks will continue the measurement 
line. Both the segment and total distance will be displayed in a separate window. Double 
click to stop the measurement. 

 
Measure Area 

Click on the map. Each click will define a measure area. A minimum of 3 points will be 
needed to define the area. The measure results window will update with each click. 
Click one of the  selection tools to select the layer 

 Selection Operation 

Capability to add, subtract, or sub�select features from an existing selection. An initial 
selection can be made using a rectangle and the specific features can be removed from 
the selection by using a different selection tool. To modify the selection, choose the 
desired option from the selection menu.  Then choose a selection tool and the feature 
criteria. Depending on the chosen selection tool click, or click and drag on the map to 
alter the selection. 
 

 Select Point Click a location on the map to add the point 

 Select Polyline Click multiple points on the map to define the polyline and then double click to end. 

 Select Polygon Click multiple points on the map to define the polygon and then double click to end. 

 Select Rectangle Click, hold and drag the mouse to define the box. Release the mouse button to end. 

 Clear Results To clear selections and then click on the specific predefined selection result definition. 

 
Help Will open the MapOptix Users Guide 

 
Print 

When the Print option is selected a form will first appear to collect user input. This 
includes choosing the template, entering a map title, adjusting the scale, specifying an 
optional date stamp, choosing which layer legends will be displayed on the map, and 
finally miscellaneous comments. Output formats include HTML and PDF. Use the 
HTML format to quickly generate a map for printing. Use the PDF option if you want to 
save the map to a file. 

 



Sidebar Menu  

Map Layer and Legend Display  

Map layer visibility control and legend display is found in the Layers Table of 
Contents or TOC (table of contents) sidebar menu.  

Multiple map services may exist with each service containing multiple map layers. In 
some cases layers may be organized in groups or group layers.  A map service will be 

identified with the  icon.  Clicking on the  or  icons in the tree view will 
expand or collapse the section of the TOC. Group layers will display as a folder  
icon.  

To better help identify the type of layer (point , line  or polygon ), without 
having to expand the layer to view the legend, an icon is displayed next to the layer 
name.  

To turn on or off the display of a map layer just click the mouse to check  or 
uncheck  the box next to the layer. 

A right click context menu also exists for the map layer. Options include the ability to 
zoom to the full extent of the layer and to display metadata (information about the 
attributes of the layer such as zoning codes and categories, soil definitions, etc.) 

 
 
Why does the layer not display when checked on?  
 
There are two reasons. One may be that the layer has scale dependencies set which prevent the layer from displaying unless the map 
scale is in the designated range. It is easy to tell if the a layer is scale dependent as the layer name and legend will be “dimmed out” if 
out of scale range compared to when the layer is within the range of the current scale.  
 
The other reason is the parent group layer is turned off. If the layer is checked on, and is available to display within the current map 
scale, then check to make sure the group and its parent group are both turned on. 
�
 
Why does the layer not display when Zoom to Layer is selected?  

This is because the layer has a scale dependency defined. Adjusting the map extent to display the entire layer results in a map scale 
that exceeds the maximum scale for the layer. Zoom in to display the layer then pan to different areas of interest. 

Queries 

One or more query panel tabs are presented depending on the site configuration. Each query panel may display one or more fields that 
can be queried. 

To perform a query, type in the search criteria and click the search button. A table will display the 
selected records and the map will display the corresponding selected features. 

If criteria is entered on multiple fields an implied “and” is used to complete the query. 

At the bottom of the query panel is a drop down menu for changing the selection type.  
Users can add, subselect, or remove records from an existing selection set. 

                                      



Selected records will be displayed in the query results table. 

�

Navigating and Highlighting Records  

A right�click on each record will display a context menu. From this menu the user can pan to or zoom to a record. This is especially 
useful when a selection spans a large geographic area. 

After a selection is performed the resulting map features will be highlighted on the map. To determine which map feature is associated 
with selected tabular record hover the mouse over the record. This will highlight the active record and will highlight the associated 

map feature is a different color. Clicking on the underlined number (the Parcel ID or PID)  will open a new window 
and display the property appraisal record for that property. 

Exporting Records  

A number of options exist to save or export selected records. Records can be displayed and saved to a PDF file , exported to KML 
 and displayed in Google Earth, exported to Excel , or to a delimited text file .  

Selection Management Tools 

The Selection Set Management icon   opens a side window that that allows you to Hide/Show the selected features on the 

map, zoom to the selected features or Clear the Selection. The Zoom icon  zooms to the selection. 

 
  

      
�



I just want to point at a parcel and get to the Property Record Card.  
 
 

Zoom in until you can turn on the parcel lines and identify the one you want.   
1. Mouse click on the Identify Tool, pick the parcel boundaries layer (this will stay as the Identify default) 
2. Click on the parcel desired. The identify results will appear,  
3. Click on the blue PID number to go the Property Record Card or Click “Right click for more” to Flash, Pan to, Zoom to or Convert 
to Markup the selected parcel.          
 
 
 

 
 
 

To clear the selection hit the Clear Tool   or the Clear button  or close the window to clear the Identify Results 
window. 
 
 

Other links may be available by going to the Right click 
for more … County Zoning has a link to the Zoning 
Classifications from the Land Development Code. 



Drawing Markups   
Users can sketch or add markup features to the map. Markup features include points, lines, polygons, rectangles, ellipses and text. The 
markup choices are accessed from the “Draw” dropdown menu on the toolbar.  To add a markup on the map, simply select the desired 
markup tool and then click on the map. For some features you will need to click and drag. The interaction needed for each markup 
type is listed in a table below. 
 

 
 

Markup Manager and Feature Properties  

The Markup Manger is located in the Markup sidebar menu. As markups are added to the map an entry will be placed into the 
appropriate markup folder.   

Right click on the word Manager to Delete all markups, save the markups to a file or load markups that you have previously saved. 

 

Right click on the feature layer (ex. Polygons) to change the properties for all features in that group. 

 

There is also a right click context menu available for each markup feature. An option exists to change the symbol properties for an 
individual markup feature. Navigation options also exist to pan to or zoom to a specific markup graphic. An option to flash a markup 
feature is useful for quickly identify a specific markup from others. You can also delete that one markup graphic individually. 

Right click on the individual feature to change it or do advanced markups. (See instructions below). 

 

 

Tool  Interaction 
Draw Polygon  Click multiple points on the map to define the polygon and then double click to end.  
Draw Polyline  Click multiple points on the map to define the polyline and then double click to end.  
Draw Rectangle  Click, hold and drag the mouse to define the box. Release the mouse button to end.  
Draw Ellipse  Click, hold and drag the mouse to define the box, which is used to define the ellipse. 

Release the mouse button to end.  
Draw Point  Click a location on the map to add the point 
Draw Text  Click a location on the map to add a text label. A form will appear to enter the text. 

Once entered, the text label will appear on the map at the clicked location.  
Draw Callouts Click location of point to start and drag to place the callout text show be. A box with 

the text will draw with a pointer to the feature. 
Delete All Markups Deletes all markups made. Use the feature properties to delete individual markups. 
Markup Properties Changes the properties for all markups made. Change individual markups by right 

clicking on the feature (see below). 



Advanced Markup Capabilities – Buffer Selection  
Markup features can also be buffered and used to perform a spatial intersection selection against other map layers.  

 

Individual markup polygons, polylines and points can be buffered by selecting the “Buffer” choice from the right�click context menu. 
A menu will display requesting a distance. Enter a distance in map units and then select “OK”. The buffer will be displayed on the 
map.  The buffer graphic is also a markup feature and will be added to the Polygons markup folder. Symbol properties can be 
changed. The buffer graphic itself can also be buffered.  

 

 

Advanced Markup Capabilities – Intersection Selection  
An existing markup graphic can in turn be used to perform a spatial intersection selection. Right�click on the desired markup and 
choose the spatial query option. A list of predefined query results will be available for specific layers. Choose the desired layer.  

The markup will be used like a cookie cutter to select features from the specified layer that fall within and intersect the markup 
feature. Selected features will be highlighted on the map.  

 



Lat/Long 
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Creating Lat/Long Points  
To add a lat/long point to the map, click the Add Lat/Long option in the menu and then click locations 
on the map. For each mouse click a point will be added to the map and labeled with the coordinate 
value.  

You can delete points by selected the “Delete All Lat/Longs” option from the menu.  

To delete individual Lat/Long Points, use the Manager in the Lat/Long Sidebar menu. Right�Click on a 
specific Lat/Long Point and then choose delete. 

You can also create points from the Lat/Long Sidebar using known coordinates. 
To add a lat/long point from the Sidebar menu choose the coordinate format, enter 
a longitude and latitude coordinate value, and then click the add button. The new 
coordinate will be drawn on the map and added to Manager list below the form.  

Lat/Long Properties  
Placed lat/long locations have both a symbol marker and a text label. Right 
clicking the lat/long in the manager shows a properties option and  provides the 
ability to change the symbol and text font. Change the properties to the desired 
settings and then click apply. 

Lat/Long symbol property changes will be applied to newly placed locations. To 
change the symbol properties of an existing location use the Lat/Long Manager in 
the Lat/Long sidebar menu. 

Saving and Loading Lat/Long Locations  
To save markups select the “Save Lat/Long” option in the dropdown menu. 
Depending on your browser you will be presented with a dialog menu to save 
markup locations to a file.  

If using Firefox, the file will be saved to the location specified in the options 
menu.  

Choose the “Load Lat/Long” option to recall and display a previously saved file 
of lat/long locations. A dialog menu will be provided to browse for a saved file. 
Options also exist to change the reporting format display.  

 

 

          Right click 

 

For the Complete Help document click on the link below  
http://imapp.vcgov.org/mox6/help/MapOptix%2060%20User%20Guide.pdf 

 


